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BBMA TRADING SYSTEM 
 
• In this ebook I want to be clear a few things, BMA secret is found in your own home, where 
your  
 
ability to understand, use the system as a discipline, patience, let greedy located. 
 
• BMA there are three main systems: 
 
1. Extreme 
 
2. MHV 
 
3. Re-Entry 
 
• In this ebook I will share all the secrets of BMA Basic without tulips, and of this system has 
also enabled many traders draw on the foreign exchange market. 
 
DEFINITIONS BMA 
 
• It is a combination of two indicators Abbreviation contained in the software Meta Trader 4 or 
MT4 iatu Bolinger Band and Moving Average. 
 
• Is the indicator 'Favourite' which is normally used by traders to determine the direction of the 
market. 
 
• Mr. Oma Ally has reconfigured its previous mode and match the use of both of these 
indicators in the FOREX market. 
 
 
• Through a lengthy research and experimentation continue, resulting Oma BMA technique is 
Ally. 
 
"Support & Resistance moving significantly from time to time" 
 
UNDERSTANDING BASIC PROPERTIES & Bolinger Band Moving Averages 
 
 
Bolinger Band 
 
• Created by the founders iatu John Bollinger in the 1980s. Nature seemed to sap that can 
expand and contract. 
 
• Two properties are often formed of BB Expands Horizontal 
 
• Bollinger Band consists of 3 lines, known as 'TOP BB, BB & LOWER MID BB'. 
 
 



• Bollinger Bands act as Support and resitance from time to time. 
 
 

 
 
 
BB EXPAND 
 
• Begin to respond to the environment when there is movement in the market movements or  
momentum in the direction of the market, Bolinger Band will inflate the larger openings 
Bollinger Band, it tells that the momentum is getting stronger. 

 
 
     MENGEMBANG   = EXPAND  OR OPEN  (become or make larger or more extensive.) 
 



 
 
 
BB HORIZONTAL 
 
 
Occurs when the movement of the market began to have momentum, Bolinger Band will begin 
to shrink and  
 
shrink again and this term called '' BB HORIZONTAL ". Phenomena such as "BB 
HORIZONTAL" This happens 
 
often after the occurrence of a fall or rise. 

 

 
 
 
 
        BB MENDATAR  = BB HORIZONTAL 
 
 
 
BB NATURE AS SUPPORT & RESISTANCE 
 
• Top BB - If the price is below. 
 
• Top BB serves as a 'Resistance' 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
BB NATURE AS SUPPORT & RESISTANCE 
 
• Mid BB - If the price is below. 
 
• Mid BB serves as a 'Resistance' 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
BB NATURE AS SUPPORT & RESISTANCE 
 
• Low BB - When price is above. 
 
• Low BB serves as a 'Support' 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
MOVING AVERAGE (MA) 
 
• The most commonly used indicator in technical analysis to determine the average value of a 
price for a period of time specified by a Time Frame. 
 
• Applied as indicators to identify trends by comparing the price movements of the MA. Trend 
more can be said to have occurred when the price moves above the MA, the down trend when 
the price moves below MA. 
 
• Used to search for indications of price trends, as well as find opportunities for entry and exit 
opportunities from existing transactions. 
 
• Serves as support and resistance for the movement of prices. When the price is above the 
MA, MA acting as support and when the price is below the MA, MA acting as resistance. 
 
 
MOVING AVERAGE (MA) 



 
 
• Indicators to analyze trends by comparing the price movement towards the MA line. Trend 
rise can be said to have occurred when the price moves above the MA, the down trend when 
the price moves below MA. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
MOVING AVERAGE (MA) 
 
• Serves as support and resistance for the movement of prices. 
 
• When the price is above the MA, MA acting as support and when the price is below the MA, 
MA acting as resistance. 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
STEPS TO SETTING UP INDICATORS ASAS BBMA CHART 
 
 
Click File> Select NEW CHART & Select currency 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Press the Ctrl + G to remove Grid & Select Candlestick 
 
Clik Insert > Indicators > Trend > Bollinger Bands 
 
Please follow settings as in the diagram and click the OK button 
 
 
Please follow settings as in the diagram and click the OK button 
 
 



 
 Indicators that are ready inserted 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
Please follow settings as in the diagram and click the OK button 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 

 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
MOVEING AVG 50 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
HOW TO SAVE TEMPLATES TEMPLATES & ENTERING INTO CHART 
 
Right click your mouse button and follow the steps in the diagram 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
HOW TO SET-UP MULTI CHART TERMINAL ::: 
 
Set Chart with M15 TF, TF H1 & H4 TF 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click File> Select Profiles> Save As> Enter the name of the currency and repeat the process to 
different currencies. 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
BASIC LAWS IN THE BBMA 
 
• 1. Moving Averages 5/10 High can not get out of the Top BB (see Figure 1) 
 
• Moving Averages 5/10 Low Low can not get out of the BB Figure 1 (see Figure 1) 
 
• # Moving Average that out of the BB marked trend started going out or want to change. 
 
• 2. Candlestick can not close off Top Low BB or BB: 
 
• a) that close off Candlestick Top BB when BB vertical mark MOMENTUM market has to go up. 
(Figure 2) 
 
• Candlestick which close off when BB BB Low declined to indicate the market has 
MOMENTUM down. (Figure 2 a) 
 



• b) that close off Candlestick Top Low BB or BB when BB horizontal marking market will 
change direction. (Figure 2 b) 
 
• - Candlestick which close off Top BB when BB horizontal means price will go down. 
 
• - to close out Candlestick Low BB when BB horizontal mean price will rise. 
 
• # indicates the absence of Volume B Flat or sideway market. 
 
• 3. The conditions for creating a Buy or Sell is as follows:  
 
• Only Buy on Moving Averages 5/10 Low only 
 
• Only Sell on Moving Averages 5/10 High Only 
 
 
• (See Figure 3) 
 
 
Figure 1 & 2 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 2 a 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 2 B 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
BB MENDATAR  =  BB  Horizontal 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 LUAR  =  EXTERNAL 
 
Figure 3 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
TYPES OF ENTRY BMMA 
 
 
• Entry BMA is divided into three (3) types: 
 
• 1. EXTREME 
 
• 2. LOST MARKET VOLUME 
 
• 3. RE-ENTRY 
 
EXTREME 



 
• Definition:  
 
• * Moving Averages are outside the Top Or Low BB and BB * Candlestick close off Top BB / 
BB Low 
 
• Normally Candlestick & MA can not be outside the body because it is often played in the BB 
range. BB control and follow price from time to time. If the price breaks out top BB / BB Low 
base it was unlawful and therefore EXTREME formed. 
 
• Extreme SELL --- Moving Averages 5/10 High out of the Top BB 
 
• Extreme BUY --- Moving Averages 5/10 out of the Low Low BB 
 
Google Translate for Business:Translator ToolkitWebsite TranslatorGlobal Market Finder 
Turn off instant translationAbout Google TranslateMobileCommunityPrivacy & 
TermsHelpSend feedback 
 
 
Click to edit and see alternate translations 
 
 
Extreme examples SELL 
 

 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Extreme examples BUY 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
  Extreme examples SELL / BUY  When BB Horizontal 
 

 
 
 

 
 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
LOST MARKET VOLUME (MHV) 
 
• Effective at the end of the trend (reversal) after a rise or fall. 
 
• Inform the momentum of an increase (BUY) or fall (SELL) already weakened or no longer 
have the resources to pursue or continue their journey. 
 
• Synonym or better known as Double Top and Double Bottom. 
 
• Formed after Extreme Buy or Sell. 
 
• MHV can be detected by checking the extreme lower body. 



• MHV valid when: --- 
 
• Price does not successfully close out Top BB / BB Low even with only leave shadow. 
• MHV void when: --- 
 
 
• Price managed to break and close off Top BB / BB Low 
 
Figure MHV (SELL) 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Figure MHV (BUY) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure MHV Cancel (Sell) 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure MHV Cancel (Buy) 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
RE-ENTRY 
 
• Formed after a fall or rise. 
 
• Price will form Sideway / Ranging for Re-Entry form. 
 
 
• Usually the price will find MA5 / 10 High to give a chance Sell entry while MA5 / 10 Low to 
allow entry Buy. 
 
Figure Example of Re-Entry (SELL) 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure Example of Re-Entry (BUY) 
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Unknown31 July 2017 at 10:18 

This comment has been removed by the author. 
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2.  

Unknown31 July 2017 at 10:18 

This comment has been removed by the author. 
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3.  

Unknown31 July 2017 at 10:20 

Hi may you please email me a complete BBMA pdf in English version. The one I have is in 
Malaysian. My email is sizgabs@gmail.com, Thank you 
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4.  

Unknown26 November 2017 at 18:19 

Good day, could you please send me an English version (complete) of the strategy, my email 
is arthurmasoka@gmail.com , thank you. 
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5.  

Unknown31 December 2017 at 07:11 

please find telegram channel names @Black0utFX for more detail about BBMA 
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6.  

Unknown31 December 2017 at 07:12 

please find telegram channel names @Black0utFX for more detail about BBMA 
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7.  

Unknown6 January 2018 at 02:02 

Please send me an English version of this strategy xxabdulmxx@gmail.com 
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8.  

Unknown1 April 2018 at 12:47 

Good afternoon, can you please email me a complete BBMA pdf in English. I will appreciate 
so much, Thank you 
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9.  



Unknown12 April 2018 at 20:36 

introducing-brokers introduce new clients to a Forex brokerage, and in return the Introducing 
Brokers earn a generous, ongoing commission. 
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10.  

Unknown13 April 2018 at 12:03 

hey please email me BBMA EBOOK English version to fishym599@live.co.uk 
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11.  

Unknown8 June 2018 at 13:48 

Please, send me the original version english to dploading@hotmail.com 
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12.  

Unknown25 June 2018 at 10:17 

Let me explain the basic principle how most Forex systems work. They are tuned up to work 
in a specific market condition. They often make money in a trending market, but loose money 
in a choppy market. It is not a problem as long as the market is trending and the system is 
making more money than it loses. Such a system can be profitable for several months and 
you would be happy with it. BUT... 
 
PREPARE FOR THE WORST... 
 
Market change over time. A well designed system starts with trend analysis to stay away from 
potentially losing trades. There are two problems of how a Forex system recognizes the trend. 
 
PROBLEM: FALSE "STRONG TREND" INDICATION. 
 
The system responds only to immediate price action. An explosive price movement that is 
usually the result of news release is tempting people to jump in and make a profit. It looks like 
a "strong trend", but what usually happens next is a hard fall. 
 
To avoid falling into this trap, check for the SOLUTION to find a REAL trend: 
 
==> http://www.forextrendy.com?nsjjd92834 
 
SECOND PROBLEM: TREND RELIABILITY 
 
Most systems use various indicators to determine the trend. Actually, there is nothing bad 
about using indicators. One Simply Moving Average can do the job. The problem comes with 
the question: "Is the market trending NOW?" Whether the market is trending or not trending 
is not like black and white. The correct question is: "How well the market is trending?" 
 
And here we have something called TREND RELIABILITY. 
 
Trends exist and they can be traded up and down for a profit. You have to focus only on the 
most reliable market trends. "Forex Trendy" is a software solution to find the BEST trending 
currency pairs, time frames and compute the trend reliability for each Forex chart: 
 
==> http://www.forextrendy.com?nsjjd92834 
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13.  

Unknown25 June 2018 at 11:25 

Do you think that to dramatically improve your success rate you have to read tons of thick 
books, buy expensive software and spend countless hours of learning more about Forex? 
 
What I'm going to share with you is something very EASY to use and very POWERFUL at the 
same time. 
 
Let me give you an EXAMPLE: 
 
Imagine you trade a system that makes 50% winning trades, but another 50% are losing 
trades. If you increase your odds of winning by only 20%, that would make 70% winning trades 
and 30% losing trades. 
 
Well, HOW TO accomplish that? 
 
Just pick the best trending pair at the current time and simply follow the trend! I have found 
ONE INCREDIBLE TOOL that continuously scans the Forex market and picks the most 
reliable trending pairs for you. 
 
http://www.forextrendy.com?ljsjhd8374h 
 
By taking signals in the direction of a strong trend you would REDUCE UNNECESSARY 
LOSSES and increase the odds of winning. You need to know "how well" the market is 
trending to avoid very short-term trends. 
 
STOP hunting the market for every potential trade. Pick only the best trending pairs and time 
frames and DO NOT take any trading signals in the choppy market (unless you know exactly 
what you are doing). 
 
Successful traders keep it simple and this is the way how the pros made fortunes in the 
markets - by trading less and making more. 
 
To increase the profitability of any system or robot you are currently using, check out this easy 
and powerful ultimate solution: 
 
http://www.forextrendy.com?ljsjhd8374h 
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14.  

seoa313 July 2018 at 02:56 

Do you think that to dramatically improve your success rate you have to read tons of thick 
books, buy expensive software and spend countless hours of learning more about Forex? 
 
What I'm going to share with you is something very EASY to use and very POWERFUL at the 
same time. 
 
Let me give you an EXAMPLE: 
 
Imagine you trade a system that makes 50% winning trades, but another 50% are losing 
trades. If you increase your odds of winning by only 20%, that would make 70% winning trades 
and 30% losing trades. 
 
Well, HOW TO accomplish that? 
 
Just pick the best trending pair at the current time and simply follow the trend! I have found 
ONE INCREDIBLE TOOL that continuously scans the Forex market and picks the most 
reliable trending pairs for you. 
 
==> http://www.forextrendy.com?ljsjhd8374h 



 
By taking signals in the direction of a strong trend you would REDUCE UNNECESSARY 
LOSSES and increase the odds of winning. You need to know "how well" the market is 
trending to avoid very short-term trends. 
 
STOP hunting the market for every potential trade. Pick only the best trending pairs and time 
frames and DO NOT take any trading signals in the choppy market (unless you know exactly 
what you are doing). 
 
Successful traders keep it simple and this is the way how the pros made fortunes in the 
markets - by trading less and making more. 
 
To increase the profitability of any system or robot you are currently using, check out this easy 
and powerful ultimate solution: 
 
==> http://www.forextrendy.com?ljsjhd8374h 
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15.  

durga14 August 2018 at 05:13 

Do you think that to dramatically improve your success rate you have to read tons of thick 
books, buy expensive software and spend countless hours of learning more about Forex? 
 
What I'm going to share with you is something very EASY to use and very POWERFUL at the 
same time. 
 
Let me give you an EXAMPLE: 
 
Imagine you trade a system that makes 50% winning trades, but another 50% are losing 
trades. If you increase your odds of winning by only 20%, that would make 70% winning trades 
and 30% losing trades. 
 
Well, HOW TO accomplish that? 
 
Just pick the best trending pair at the current time and simply follow the trend! I have found 
ONE INCREDIBLE TOOL that continuously scans the Forex market and picks the most 
reliable trending pairs for you. 
 
http://www.forextrendy.com?vhbshygdf398432 
 
By taking signals in the direction of a strong trend you would REDUCE UNNECESSARY 
LOSSES and increase the odds of winning. You need to know "how well" the market is 
trending to avoid very short-term trends. 
 
STOP hunting the market for every potential trade. Pick only the best trending pairs and time 
frames and DO NOT take any trading signals in the choppy market (unless you know exactly 
what you are doing). 
 
Successful traders keep it simple and this is the way how the pros made fortunes in the 
markets - by trading less and making more. 
 
To increase the profitability of any system or robot you are currently using, check out this easy 
and powerful ultimate solution: 
 
http://www.forextrendy.com?vhbshygdf398432 
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16.  

Unknown15 August 2018 at 04:00 



Do you think that to dramatically improve your success rate you have to read tons of thick 
books, buy expensive software and spend countless hours of learning more about Forex? 
 
What I'm going to share with you is something very EASY to use and very POWERFUL at the 
same time. 
 
Let me give you an EXAMPLE: 
 
Imagine you trade a system that makes 50% winning trades, but another 50% are losing 
trades. If you increase your odds of winning by only 20%, that would make 70% winning trades 
and 30% losing trades. 
 
Well, HOW TO accomplish that? 
 
Just pick the best trending pair at the current time and simply follow the trend! I have found 
ONE INCREDIBLE TOOL that continuously scans the Forex market and picks the most 
reliable trending pairs for you. 
 
http://www.forextrendy.com?vhbshygdf398432 
 
By taking signals in the direction of a strong trend you would REDUCE UNNECESSARY 
LOSSES and increase the odds of winning. You need to know "how well" the market is 
trending to avoid very short-term trends. 
 
STOP hunting the market for every potential trade. Pick only the best trending pairs and time 
frames and DO NOT take any trading signals in the choppy market (unless you know exactly 
what you are doing). 
 
Successful traders keep it simple and this is the way how the pros made fortunes in the 
markets - by trading less and making more. 
 
To increase the profitability of any system or robot you are currently using, check out this easy 
and powerful ultimate solution: 
 
http://www.forextrendy.com?vhbshygdf398432 
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17.  

yousuf17 August 2018 at 04:47 

Do you think that to dramatically improve your success rate you have to read tons of thick 
books, buy expensive software and spend countless hours of learning more about Forex? 
 
What I'm going to share with you is something very EASY to use and very POWERFUL at the 
same time. 
 
Let me give you an EXAMPLE: 
 
Imagine you trade a system that makes 50% winning trades, but another 50% are losing 
trades. If you increase your odds of winning by only 20%, that would make 70% winning trades 
and 30% losing trades. 
 
Well, HOW TO accomplish that? 
 
Just pick the best trending pair at the current time and simply follow the trend! I have found 
ONE INCREDIBLE TOOL that continuously scans the Forex market and picks the most 
reliable trending pairs for you. 
 
http://www.forextrendy.com?vhbshygdf398432 
 
By taking signals in the direction of a strong trend you would REDUCE UNNECESSARY 
LOSSES and increase the odds of winning. You need to know "how well" the market is 
trending to avoid very short-term trends. 
 



STOP hunting the market for every potential trade. Pick only the best trending pairs and time 
frames and DO NOT take any trading signals in the choppy market (unless you know exactly 
what you are doing). 
 
Successful traders keep it simple and this is the way how the pros made fortunes in the 
markets - by trading less and making more. 
 
To increase the profitability of any system or robot you are currently using, check out this easy 
and powerful ultimate solution: 
 
http://www.forextrendy.com?vhbshygdf398432 
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Jimmy2 November 2018 at 07:48 

How can this strategy be used to determine the makert direction for news reports?? 
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19.  

Unknown15 December 2018 at 05:26 

Great article 
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20.  

Unknown29 December 2018 at 05:15 

Great article... very insightful ڕ 
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21.  

Unknown5 February 2019 at 17:17 

Plz can you send me the complete bbma oma ally strategy at asalezomsutu@mail.com 
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22.  

Unknown2 July 2019 at 18:12 

Please send me a complete bbma pdf 

Reply 

23.  

Flora shawn16 January 2020 at 04:36 

i was once living on the street where by things were so hard for me, even to pay off my bills 
was very difficult for me i have to park off my apartment and start sleeping on the street of 
Vegas. i tried all i could do to secure a job but all went in vain because i was from the black 
side of America. so i decided to browse through on my phone for jobs online where i got an 
advert on Hackers advertising a Blank ATM card which can be used to hack any ATM Machine 
all over the world, i never thought this could be real because most advert on the internet are 



based on fraud, so i decided to give this a try and look where it will lead me to if it can change 
my life for good. i contacted this hackers and they told me they are from Australia and also 
they have branch all over the world in which they use in developing there ATM CARDS, this 
men who were geeks and also experts at ATM repairs, programming and execution who 
taught me various tips and tricks about breaking into an ATM Machine with a Blank ATM card.i 
applied for the Blank ATM card and it was delivered to me within 3 days and i did as i was told 
to and today my life has changed. there is no ATM MACHINES this BLANK ATM CARD 
CANNOT penetrate into, because it has been programmed with various tools and software 
before it will be send to you. i know this is illegal but also a smart way of living Big because 
the government cannot help us so we have to help our self. if you also want this BLANK ATM 
CARD you can contact these Hackers at 
email: skylinktechnes@yahoo.com whatsapp: +1(213)785-1553 or website: 
https://skylinktechnes.wixsite.com/info 

 


